
 

 

 
 
ACI Release 3.14 
Settings Reference 
 

 



 

ACI Release 3.14 - Settings Reference ii 

Copyright 

© 2012, 2025 T-Systems International GmbH. 

All rights reserved. Printed in Germany. 

Issued by 

T-Systems International GmbH 

Business Unit Product Lifecycle Management 

Fasanenweg 5 

70771 Leinfelden-Echterdingen 

Germany 

Contacts 

web: http://www.cmi-support.com 

email: cmi_support@t-systems.com 

phone: +49 (0) 40 30600-5544 

Brief details 

Settings reference for ACI. 

This guide lists settings of ACI. 

Before using this guide, be sure you understand: 

▪ the administration of 3DEXPERIENCE, 

▪ the administration of Aras Innovator. 

Trademarks 

3DEXPERIENCE is a registered trademark of Dassault Systèmes. 

Aras and Aras Innovator are registered trademarks of Aras Corporation. 

Oracle is a registered trademark of Oracle Corporation. 

Names of other products mentioned in this manual are used only for identification 

purpose and may be trademarks of their companies. 

 
  

http://www.cmi-support.com/
mailto:cmi_support@t-systems.com


 

ACI Release 3.14 - Settings Reference iii 

Table of Contents 

1 Overview ....................................................................................................... 1 

2 General Settings ........................................................................................... 2 

2.1 Conversion ..................................................................................................... 2 
2.2 PDM ............................................................................................................ 12 
2.3 Aras ............................................................................................................. 16 
2.4 Enovia.......................................................................................................... 20 
2.5 Features ...................................................................................................... 24 

3 Administration settings .............................................................................. 26 

3.1 Administration .............................................................................................. 26 
3.2 Pdm ............................................................................................................. 33 
3.3 Aras ............................................................................................................. 35 
3.4 Enovia.......................................................................................................... 36 
3.5 XciWeb ........................................................................................................ 41 
3.6 Scheduler..................................................................................................... 42 
3.7 TSI3DXBatch ............................................................................................... 44 
3.8 COMReconV5 .............................................................................................. 48 
3.9 FileConversion ............................................................................................. 49 

 



 Overview 

ACI Release 3.14 - Settings Reference 1 

1 Overview 

ACI settings are organized in two clusters: 

• general settings control mapping between Aras Innovator and 3DEXPERIENCE, for 

example custom attribute mapping or state mapping 

• administration settings control infrastructure configurations, for example server connection 

definitions for Aras Innovator and 3DEXPERIENCE 

Settings are stored in two XML files in the XCI_HOME directory: 

• XCISettings.xml contains the general settings 

• XCIAdminSettings.xml contains the administration settings 

This reference lists the settings for each category.  
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2 General Settings 

The file XCISettings.xml in XCI_HOME defines settings that control mapping between Aras 

Innovator and 3DEXPERIENCE, for example custom attribute mappings, state mappings or which 

file types to export. 

It is divided into sections: 

• Conversion: contains mapping settings that affect both systems (e.g. mapping of Release 

status) 

• Pdm: settings for Aras Innovator export or import 

• Aras: specific settings Aras Innovator 

• Enovia: specific settings for 3DEXPERIENCE 

• Features: enable or disable ACI features 

The next subchapters list settings available in these sections. 

2.1 Conversion 

2.1.1 DisablePdmImportSkipNotModified 

To disable the skipping the import of objects to Aras Innovator which are not modified since the last 

import, it must be set to true. Default setting is false. 

<DisablePdmImportSkipNotModified>true</DisablePdmImportSkipNotModified> 

2.1.2 DummyProductData 

Define a placeholder Part that is imported into 3DEXPERIENCE for Parts excluded from Aras 

Innnovator export – see 2.1.4. 

<DummyProductData> 

    <Type>Part</Type> 

    <ID>MyDummy</ID> 

    <Revision>1</Revision> 

    <Name>Replace</Name> 

    <Description>DummyPart for ExclusionList</Description> 

    <Owner>Owner</Owner> 

    <String>Display String</String> 

</DummyProductData> 

2.1.3 ExclusionCATProductsListFile 

Define a list of objects for which the CATProduct files should be ignored for 3DEXPERIENCE import. 

See 2.1.4 for an example of an exclusion list file. 

<ExclusionCATProductsListFile> 

  C:\tmp\exclusioncplist.xml 
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</ExclusionCATProductsListFile> 

2.1.4 ExclusionListFile 

Define Parts that should not be exported from Aras Innovator. 

Set replaceWithDummy to true to replace excluded Parts with a placeholder Part defined in 

DummyProductData setting – see 2.1.2. The placeholder object will be imported into 

3DEXPERIENCE.  

Note: every excluded Part will be replaced with the same placeholder Part 

<ExclusionListFile replaceWithDummy=”false”> 

  C:\tmp\exclusionlist.xml 

</ExclusionListFile> 

Example for an exclusion list file: 

<?xml version="1.0" encoding="utf-8" standalone="yes"?> 

<EL> 

  <ItemRev> 

    <Id>000123</Id> 

    <Type>Part</Type> 

    <Revision>A</Revision> 

  </ItemRev> 

  <Item> 

    <Id>000567</Id> 

    <Type>Part</Type> 

   </Item> 

</EL> 

2.1.5 HandleAuxFileAsMainFile 

Relevant for PDM to 3DX. True to handle auxiliary files (non-BOM CATParts) like main files -> Create 

Product and Rep3DAggr in XpdmXml. Default value is false. 

<HandleAuxFileAsMainFile>true</HandleAuxFileAsMainFile> 

2.1.6 IgnoreNon3DPartGeometries 

Enables the ignoring of geometries which are not 3DPart in 3DEXPERIENCE if enabled. Disabled 

by default. 

<IgnoreNon3DPartGeometries enabled=”true” /> 

2.1.7 OverwriteReleasedWithForce 

True to update released objects if force is true. Disabled by default. 

<OverwriteReleasedWithForce>true</OverwriteReleasedWithForce> 
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2.1.8 Part3DTypeList 

List of file types which should be imported as 3DPart product type to 3DEXPERIENCE, the default 

is 'CATPart'. 

<Part3DTypeList> 

  <Part3DType>CATPart</Part3DType> 

</Part3DTypeList> 

2.1.9 PartNumberMapping 

Modify part numbers when transferring by adding a prefix and / or suffix to the part number. This can 

be set in general for all types or type specific. Disabled by default. 

Note: when changed part number mapping is only used for new objects that have not been 

transferred yet. Previously transferred objects or new revisions of such objects will be transferred 

with the old mapping. 

• To3DXPrefix: prefix to add when transferring to 3DEXPERIENCE 

• To3DXPostfix: suffix to add when transferring to 3DEXPERIENCE 

• ToPDMPrefix: prefix to add when transferring to Aras Innovator 

• ToPDMPostfix: suffix to add when transferring to Aras Innovator 

For type specific mappings with TypeMapping: 

• set typePDM when transferring to 3DEXPERIENCE and specify the source Aras Innovator 

type 

• set type3DX when transferring to Aras Innovator and specify the source 3DEXPERIENCE 

type 

<PartNumberMapping enabled="true"> 

  <Default> 

    <To3DXPrefix>ACI_</To3DXPrefix> 

  </Default> 

  <TypeMapping typePDM="MyPart"> 

    <Mapping> 

      <To3DXPrefix/> 

      <To3DXPostfix/> 

      <ToPDMPrefix/> 

      <ToPDMPostfix/> 

   </Mapping> 

  </TypeMapping> 

 <TypeMapping type3DX="MyPhysicalProduct"> 

   <Mapping> 

    ... 

   </Mapping> 

  </TypeMapping> 

</PartNumberMapping> 
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2.1.10 PdmExportValidation 

Define validation checks to run during Aras Innovator export. Each check is disabled by default and 

must be enabled. The optional onlyWarning flag can be set to handle a check only as warning 

condition and continue processing. 

• AttributeCheck checks the maximum length of an exported attribute specified by 

maxlength. Optionally, the attribute value can be truncated if the maximum length is 

exceeded by setting the truncate flag. 

• InstanceNameCheck checks the uniqueness of instance names under a parent object. 

• FileRefCheck checks multiple use of the same File Ref from different objects. 

• FileNameCheck checks the uniqueness of file names in the files section. 

• ProductLeafRepresentationCheck checks the existence of an attached 

Representation at a Product node if the Product node is a leaf node. 

• RepNameCheck checks for duplicate representation names by checking ID Attribute in 

Rep3D, Drawing, Document, and GenericDocument object. 

• ValidateMainFileCount checks if more than one main file is attached. 

• ValidateMissingFileForDocument checks if a file for document is attached. 

• ValidateMultipleReferencedDocument checks if a document is referenced by more 

than one part. 

• ValidateMultipleRevisions checks if more than one revision of the same part is found. 

• ValidateIncorrectRevisionSequence checks if the revision sequence is correct. 

• InvalidCharactersObjectNameCheck: 3DEXPERIENCE does not allow certain set of 

characters for business object names. Validate object names and, if configured, replace them 

either all with the same string or configure specific replacement strings per invalid character. 

Enabled by default. Disallowed characters: \*$?"',;\n\r 

<PdmExportValidation> 

  <AttributeCheck enabled="true"> 

    <XType xname ="Product"> 

      <XAttribute xname="Description"  

                  mappingtype="DefaultCustomization" 

     maxlength="60" 

     truncate="true" /> 

    </XType> 

  </AttributeCheck> 

  <InstanceNameCheck enabled="true" /> 

  <FileRefCheck enabled="false" /> 

  <FileNameCheck enabled="false" /> 

  <ProductLeafRepresentationCheck enabled="false" onlyWarning="true" /> 

  <RepNameCheck enabled="true" /> 

  <ValidateMainFileCount enabled="true" /> 

  <ValidateMissingFileForDocument enabled="true" /> 

  <ValidateMultipleReferencedDocument enabled="true" /> 

  <ValidateMultipleRevisions enabled="true" /> 

  <ValidateIncorrectRevisionSequence enabled="true" /> 

  <InvalidCharactersObjectNameCheck enabled="true"> 

    <InvalidCharacterReplacement invalidCharacter="$"  

                                 replaceWith="-#-" /> 
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  </InvalidCharactersObjectNameCheck> 

</ PdmExportValidation> 

2.1.11 PdmImportValidation 

Define validation checks before Aras Innovator import. 

• AttributeCheck checks the maximum length of an exported attribute specified by 

maxlength. Optionally, the attribute value can be truncated if the maximum length is 

exceeded by setting the truncate flag. 

• UnknownDocumentTypeStrategy defines the handling of unmapped document types 

during transfer. If there is no V6FileFormat mapping available for an exported file from 

3DEXPERIENCE, this setting will define how to handle Aras Innovator import.  

o WARNING: Default. No unmapped files will be transferred. The transfer will finish in 

state “Warning” and more information can be found in the report. 
o ERROR: Unmapped files will cause the transfer to fail. No data will be transferred. 

o IMPORT: Unmapped files will be transferred using the settings in 

GenericDocumentFormat - see chapter 2.1.25 for more information. No warning 

or error will be reported. 

<PdmImportValidation> 

  <AttributeCheck enabled="true"> 

    <XType xname ="Product"> 

      <XAttribute xname="Description" 

     mappingtype="DefaultCustomization" 

     maxlength="60" 

     truncate="true" /> 

 </XType> 

  </AttributeCheck> 

  <UnknownDocumentTypeStrategy>WARNING</UnknownDocumentTypeStrategy> 

</ PdmImportValidation> 

2.1.12 PdmStatusUpdateHandling 

Set status to related objects on Aras Innovator import that are not directly mapped from a 

3DEXPERIENCE object. 

• sourceType: Part type for which additional objects are updated 

• targetRelation: relation which attaches the secondary object (e.g. Part CAD) 

• targetObjectType: type of the secondary object 

If specified relation and target object are found below the source object, then the target object status 

is mapped according to V6MaturityToPdmStatusMapping. If the target object type is not 

configured in V6MaturityToPdmStatusMapping, it is mapped based on the parent object. 

<PdmStatusUpdateHandling enabled=”true”> 

  <AdditionalPdmStatusUpdate sourceType=”Part” 

       targetRelationType="Part CAD” 

       targetObjectType=”CAD” /> 

</PdmStatusUpdateHandling> 
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2.1.13 PdmStatusToV6MaturityMappingList 

Define mapping from Aras Innovator status to 3DEXPERIENCE maturity state for transferring 

objects to 3DEXPERIENCE. 

• v6maturity: target maturity in 3DEXPERIENCE 

• pdmTyp: for which Aras Innovator type to apply on Aras Innovator export 

• pdmstatus: source Aras Innovator status 

This mapping can be switched on or off with the enabled flag. Disabled by default. 

<PdmStatusToV6MaturityMappingList enabled=”true”> 

  <PdmStatusToV6MaturityMapping v6maturity=”RELEASED” 

      pdmTyp=”Part” 

                                pdmstatus=”Released” /> 

</PdmStatusToV6MaturityMapping> 

2.1.14 PdmV6FileType 

Define mapping of exported files from Aras Innovator to 3DEXPERIENCE representation type. 

• fileextension: specify file extension for which to apply this mapping, can contain wildcard 

* 

• doctype: document type in Aras Innovator from which the file is exported 

• fileformat: optional format of the representation for 3DEXPERIENCE import if 

fileextension is not the format (e.g. when fileextension contains wildcards) 

• aux: true if it is an aux doucment, default is false 

• filenameSuffix: Suffix which is appended to filename on Aras download. Can be used to 

differentiate files with the same name but belonging to different documents attached to the 

Part (e.g. Part geometry and drawing). 

Each V6Representation defines a RepresentationType and optionally a DerivedType. 

RepresentationType can be one of Drawing, Rep3D, Rep3DAndOriginalDocument, 

Product, ProductOrRep3D, Document, or GenericDocument. If representation type is not set, 

it must be defined with a customization implementation. 

<PdmV6FileType> 

  <V6Representation fileextension="CATPart" doctype="CAD"> 

    <RepresentationType>Rep3D</RepresentationType> 

  </V6Representation> 

</PdmV6FileType> 

2.1.15 Projects 

Define target 3DEXPERIENCE collaborative space, user and organization for objects imported to 

3DEXPERIENCE. The Projects section must include one DefaultProject that will contain 

default mapping.  

This can be overridden by a customization endpoint. 

• ProjectName: owning collaborative space in 3DEXPERIENCE 

• Organization: owning organization in 3DEXPERIENCE 
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• Owner: owning user in 3DEXPERIENCE 

• LifeCycle: policy for created 3DEXPERIENCE objects, can be override by policy mapping 

(see 2.1.23) 

• Maturity: default 3DEXPERIENCE maturity for Aras Innovator objects with status, can be 

overridden by maturity mapping (see 2.1.242.1.23) 

• optional default 3DEXPERIENCE maturity mappings, can be overridden by maturity mapping 

(see 2.1.24) 

o MaturityNoStatus: Aras Innovator objects without status 

o DocumentMaturity: Aras Innovator non-CAD datasets with status that will be 

imported as Document 

o DocumentMaturityNoStatus: Aras Innovator non-CAD datasets without status 

that will be imported as Document 

o GenericDocumentMaturity: Aras Innovator non-CAD datasets with status that 

will be imported as GenericDocument 

o GenericDocumentMaturityNoStatus: Aras Innovator non-CAD datasets without 

status that will be imported as GenericDocument 

• optional default policy for created 3DEXPERIENCE objects, can be override by policy 

mapping (see 2.1.23) 

o DocumentLifeCycle: Aras Innovator non-CAD datasets that will be imported as 

Document 

o GenericDocumentLifeCycle: Aras Innovator non-CAD datasets that will be 

imported as GenericDocument 

<Projects> 

  <DefaultProject name="Default"> 

    <ProjectName>Common Space</ProjectName> 

    <Organization>Company Name</Organization> 

    <Owner>DemoDesigner</Owner> 

    <LifeCycle>VPLM_SMB_Definition_MajorRev</LifeCycle> 

    <Maturity>RELEASED</Maturity> 

    <MaturityNoStatus>IN_WORK</MaturityNoStatus> 

    <DocumentLifeCycle>Document Release</DocumentLifeCycle> 

    <DocumentMaturity>RELEASED</DocumentMaturity> 

    <DocumentMaturityNoStatus>IN_WORK</DocumentMaturityNoStatus> 

    <GeneralDocumentLifeCycle> 

      Controlled Production Release Rev2 

    </GeneralDocumentLifeCycle> 

    <GeneralDocumentMaturity>Released</GeneralDocumentMaturity> 

    <GeneralDocumentMaturityNoStatus> 

      WIP 

    </GeneralDocumentMaturityNoStatus> 

  </DefaultProject> 

</Projects> 

2.1.16 RenameDuplicateInstanceNames 

Used to rename duplicate instance names. Duplicates will be renamed to the Object Id of the relation. 
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The default setting is “false”. 

<RenameDuplicateInstanceNames>true</RenameDuplicateInstanceNames> 

2.1.17 RevisionCleanupForPdm 

Control behavior during revise in Aras Innovator. 

If cleanChildren is enabled, all children are removed for new revisions of existing Parts during 

Aras Innovator import. 

If cleanDocuments is enabled, all objects that are attached by one of the defined relations 

(ExpandRelationType) and belong to one of the listed types (ExpandType) are removed for new 

revisions of existing Parts during Aras Innovator import. Disabled by default. 

<RevisionCleanupForPdm> 

  <cleanChildren enabled="true" /> 

  <cleanDocuments enabled="true"> 

    <ExpandRelationType>Part CAD</ExpandRelationType> 

    <ExpandType>CAD</ExpandType> 

  </cleanDocuments> 

</RevisionCleanupForPdm> 

2.1.18 SetTimeModified 

Control if modification date is written for XPDM import. Modification date controls whether data needs 

to be updated on 3DEXPERIENCE import or can just be referenced. Disabling write of modification 

date will update the object on every import. 

By default, write of modification date is enabled. This can be disabled per class of 3DEXPERIENCE 

object: Rep3D, Drawing, Document, GenericDocument, ProductFile, Product, and 

ProductInst. 

This optimization can be disabled, e.g. to resolve multi model links in several contexts. 

<SetTimeModified enabled=”true”> 

  <Rep3D disabled ="true" /> 

  <Drawing disabled ="true" /> 

  <Document disabled ="true" /> 

  <GenericDocument disabled="true" /> 

  <ProductFile disabled="true" /> 

  <Product disabled="true" /> 

  <ProductInst disabled="true" /> 

</SetTimeModified> 

2.1.19 SharedFileTypeExtensions 

Control if 3D or Drawing representations are imported to 3DEXPERIENCE as aggregated or shared. 

By default, representations are imported as aggregated. 

For all file extensions specified a shared representation will be imported to 3DEXPERIENCE. 
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<SharedFileTypeExtensions> 

 <SharedFileTypeExtension>model</SharedFileTypeExtension> 

 <SharedFileTypeExtension>cgr</SharedFileTypeExtension> 

 <SharedFileTypeExtension>CATDrawing</SharedFileTypeExtension> 

</SharedFileTypeExtensions> 

2.1.20 TimeModifiedExclusionListFile 

Define a list of objects for which modification date should be changed or removed. If 

removeTimeStamp flag is set, modification date is removed otherwise it will be reduced by two 

seconds. 

<TimeModifiedExclusionListFile removeTimeStamp="false"> 

  C:\tmp\exclusiontmlist.xml 

</TimeModifiedExclusionListFile> 

2.1.21 TypeMapping 

Define type mapping between 3DEXPERIENCE and Aras Innovator object types to map custom 

types. Disabled by default. 

<TypeMapping enabled="true"> 

  <V6ToPdm> 

    <Mapping v6Type="VPMReference" pdmType="Part"/> 

   </V6ToPdm> 

  <PdmToV6> 

    <Mapping v6Type="VPMReference" pdmType="Part"/> 

   </PdmToV6> 

</TypeMapping> 

2.1.22 UnitConversionDefinition 

Defines a list of conversions between different units to be applied during Aras Innovator import or 

3DEXPERIENCE import. Attributes exported from the source system might not be exported in the 

unit which is displayed in the user interface. For example, in 3DEXPERIENCE an attribute with input 

unit “cm” is exported with unit “m”. 

Conversion calculation: new_value = old_value * multiplier + offset. 

The unit conversions are applied during import of custom attributes in Aras Innovator or 

3DEXPERIENCE when the conversion is specified in the CustomAttributeMapping (see section 

for Aras Innovator 2.2.2 and section 2.4.1 for 3DEXPERIENCE import). 

<UnitConversionDefinition> 

  <UnitConversionname="kelvinToFahrenheit" unit="F" > 

    <Multiplier>1.7999999999999985600000000000012</Multiplier> 

    <Offset>-459.66999999999923226400000000061</Offset>   

  </UnitConversion> 

  <UnitConversion name="FahrenheitToKelvin" unit="K" > 

    <Multiplier>0.555555555555556</Multiplier> 
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    <Offset>255.372222222222</Offset> 

  </UnitConversion> 

</UnitConversionDefinition> 

2.1.23 V6LifecycleForPdmTypeMappingList 

Specify 3DEXPERIENCE policy when creating objects in 3DEXPERIENCE based on the source 

Aras Innovator object type. 

• pdmtyp: source Aras Innovator object type 

This mapping can be switched on or off with the enabled flag. Disabled by default. 

<V6LifecycleForPdmTypeMappingList enabled=”true”> 

  <V6LifecycleForPdmType pdmtyp=”Part”> 

    VPLM_SMB_Definition_MajorRev 

  </V6LifecycleForPdmType> 

</V6LifecycleForPdmTypeMappingList> 

2.1.24 V6MaturityToPdmStatusMappingList 

Define mapping from 3DEXPERIENCE maturity state to Aras Innovator status for transferring 

objects to Aras Innovator. 

• v6maturity: source maturity in 3DEXPERIENCE 

• pdmTyp: for which Aras Innovator type to apply on Aras Innovator import 

• pdmstatus: which Aras Innovator status to set 

This mapping can be switched on or off with the enabled flag. Disabled by default. 

<V6MaturityToPdmStatusMappingList enabled=”true”> 

  <V6MaturityToPdmStatusMapping v6maturity=”RELEASED” 

      pdmTyp=”Part” 

                                pdmsubtyp=”Component” 

                                pdmstatus=”Released” /> 

  <V6MaturityToPdmStatusMapping v6maturity=”RELEASED” 

      pdmTyp=”CAD” 

                                pdmsubtyp=”Mechanical/Part” 

                                pdmstatus=”Released” /> 

</V6MaturityToPdmStatusMappingList> 

2.1.25 V6PdmFileType 

Define which Files are imported to Aras Innovator and their target Document type and relation type. 

There can be multiple V6FileFormat and ImportFormat blocks and a single 

GenericDocumentFormat block. 

Each V6FileFormat defines a Main section for mapping of aggregated 3DEXPERIENCE 

representations and an AUX section for mapping of shared 3DEXPERIENCE representations. 
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Each ImportFormat block defines mapping for additional files besides the main geometry file that 

have been exported from 3DEXPERIENCE. For example, images for thumbnails or secondary 

geometry files, like .dxf file for .CATDrawing. 

GenericDocumentFormat defines, how unmapped document types will be handled, when the 

strategy is set to IMPORT (see chapter 2.1.10 for more details). 

Mapping options:  

• PdmDocType: Dataset type to create in Aras Innovator 

• PdmDocRelation: name of relation between Part and Document 

• PdmRefType: type of named reference 

• RemoveOrigExtensionForPdm: true if the original file extension should be removed from 

the filename, e.g. rename the image myfile.CATPart.png to myfile.png. Default is false. 

• UseOrigFileNameForPdm: true to use the original filename as exported from 

3DEXPERIENCE. Default is false. 

• UseOrigFileNameForDocumentName: true to use the original filename as exported from 

3DEXPERIENCE for the Document created in Aras Innovator. Default is false. 

<V6PdmFileType> 

  <V6FileFormat v6format="CATPart"> 

    <Main> 

      <PdmDocType>CAD</PdmDocType> 

  <PdmDocRelation>Part CAD</PdmDocRelation> 

  <PdmRefType>native_file</PdmRefType> 

     </Main> 

  </V6FileFormat> 

  <ImportFormat fileFormat = "PNG" v6PdmType="Rep3D"> 

    <PdmDocType>CAD</PdmDocType> 

    <PdmDocRelation>Part CAD</PdmDocRelation> 

    <PdmRefType>thumbnail</PdmRefType> 

  </ImportFormat> 

  <GenericDocumentFormat> 

    <PdmDocType>Document</PdmDocType> 

    <PdmDocRelation>Part Document</PdmDocRelation> 

    <PdmRefType>native_file</PdmRefType> 

  </GenericDocumentFormat> 

</V6PdmFileType> 

2.2 PDM 

2.2.1 CreatePartClass 

Name of the Aras Innovator type to use for new Parts.  

The default class is “Part”. This behavior can be changed by overwriting the 

com.tsystems.xci.customization.CustomPartType class. 

<CreatePartClass>Part</CreatePartClass> 
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2.2.2 CustomAttributeMapping 

Define custom type and attributes that are exported from Aras Innovator or imported to Aras 

Innovator. Disabled by default. 

A list of CustomObject definitions specifies the object types and their attributes. 

• type: Aras Innovator object type 

• mappingtype: intermediate mapping type to / from which the Aras Innovator object type is 

mapped 

• xname: 3DEXPERIENCE object class (Product, Rep3D, Drawing, Document, …) 

• createType: optional type of Aras Innovator object to create when object with above 

mappingtype is first created in Aras Innovator 

A CustomObject may contain multiple CustomAttribute. 

• name: Aras Innovator name of the attribute 

• xname: intermediate mapping name of the attribute to / from which the Aras Innovator 

attribute is mapped 

• type: attribute type, one of string, boolean, dateTime, double, duration, integer or 

positiveInteger 

• export: true to export this attribute from Aras Innovator, default value is false 

• import: true to import this attribute from Aras Innovator, default value is true 

• core: true if this attribute should be mapped to a XPDMXML standard attribute on export or 

from a standard attribute on import. Default value is false. 

• maxlength: maximum length of the attribute 

• truncate: true to truncate attribute value if maxlength is exceeded 

• defaultValue: set a default value on Aras Innovator import if the attribute is empty 

• unitConversionImport: to convert the attribute value to a different unit on Aras Innovator 

import. Set attribute to name of a conversion as defined in UnitConversionDefinition 

(see 2.1.22). 

<CustomAttributeMapping enabled="true"> 

  <CustomObject xname="Product" type="Part" 

      mappingtype="DefaultCustomization"> 

    <CustomAttribute xname="Description" 

                     name="description"  

                     type="string"  

                     export="true"  

                     import="false" /> 

  </CustomObject> 

</CustomAttributeMapping> 

2.2.3 DocumentRelations 

Defines the relation types to be followed to Documents when exporting from Aras Innovator. 

<DocumentRelations> 

  <Relation>Part CAD</Relation> 

</DocumentRelations> 
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2.2.4 DocumentRevisionSeparator 

The revision may be part of the document name. (e.g. 000123/B). If the document is copied with 

each revision, but the name changes to include the new revision (e.g. 000123/C), the mapped name 

in V6 would change as well. To get consistent naming, this separator can be defined. The document 

name will be split at the last occurrence of the configured separator and the revision will be discarded 

when naming the document in V6. 

<DocumentRevisionSeparator>/<DocumentRevisionSeparator> 

2.2.5 ExportWithStateFilter 

If enabled only objects with the configured state are exported from Aras Innovator. The value is a 

comma separated list of allowed states. Disabled by default. 

<ExportWithStateFilter enabled="true"> 

  Frozen,Released 

</ExportWithStateFilter> 

2.2.6 GetMetadataSettings 

Define the attributes which are returned from the Show Aras Innovator Attributes command in the 

ACI 3DEXPERIENCE Rich Client. 

<GetMetadataSettings> 

  <!-- used as default for all Parts with subclasses -->  

  <ResultAttributeNames pdmType="Part"> 

   <ResultAttributeName>item_number</ResultAttributeName> 

   <ResultAttributeName>major_rev</ResultAttributeName> 

   <ResultAttributeName>name</ResultAttributeName> 

   <ResultAttributeName>state</ResultAttributeName> 

   <ResultAttributeName>classification</ResultAttributeName> 

  </ResultAttributeNames> 

</GetMetadataSettings> 

2.2.7 IgnoreRemoveNonExistingDocuments 

Disable the remove non existing document functionality. Default value is false. 

<IgnoreRemoveNonExistingDocuments> 

  true 

</IgnoreRemoveNonExistingDocuments> 

2.2.8 MetaUpdate 

The MetaUpdate section defines the Aras Innovator and 3DEXPERIENCE attributes for the 

metadata update command. Disabled by default. 

MetaObject defines the Aras Innovator type with the type attribute. The MetaAttribute defines 

the attributes for the update functionality. 
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• name: the attribute name in Aras Innovator. 

• v6name: the 3DEXPERIENCE attribute name 

<MetaUpdate enabled="true"> 

  <MetaObject type="Part"> 

    <MetaAttribute name="name"   

                   v6name="attribute[PLMEntity.V_Name]"/> 

    <MetaAttribute name="description"  

                   v6name="attribute[PLMEntity.V_description]"/> 

  </MetaObject> 

</MetaUpdate>  

2.2.9 OverwriteOriginal 

Set to false to prevent overwriting of data originating from Aras Innovator (after CLOC). Enabled 

by default. 

<OverwriteOriginal enabled="true" /> 

2.2.10 ReallyRemoveExistingNotProvided 

Setting whether to remove unknown occurrences in Aras Innovator or not. Disabled by default. 

<ReallyRemoveExistingNotProvided enabled="true" /> 

2.2.11 RevisionQuerySettings 

Define settings for running Aras Innovator Part queries. RevisionTypes defines list of object types 

to search for, use empty RevisionType for search all types. 

RevisionAttributeNames contains a mapping of Aras Innovator display attribute name to 

internal attribute name. 

ResultAttributeNames lists which attributes should be returned. If empty, all attributes are 

returned.  

MaxResultToReturn specifies a maximum number of matches to be returned. Default value is 0, 

which means no limit. 

<RevisionQuerySettings> 

  <RevisionTypes> 

    <!-- Use empty RevisionType for search all types. --> 

    <RevisionType/> 

    <RevisionType>Part</RevisionType> 

  </RevisionTypes> 

  <RevisionAttributeNames> 

    <RevisionAttributeName display="Part Number"> 

      item_number 

    </RevisionAttributeName> 

    <RevisionAttributeName display="Revision"> 
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      major_rev 

    </RevisionAttributeName> 

    <RevisionAttributeName display="Name"> 

       Name 

    </RevisionAttributeName> 

    <RevisionAttributeName display="Type" > 

      Classification 

    </RevisionAttributeName> 

  </RevisionAttributeNames> 

  <!-- If ResultAttributeNames tag does not exist, then all not empty  

       attributes are returned. --> 

  <ResultAttributeNames> 

    <ResultAttributeName>item_number</ResultAttributeName> 

    <ResultAttributeName>major_rev</ResultAttributeName> 

    <ResultAttributeName>name</ResultAttributeName> 

    <ResultAttributeName>classification</ResultAttributeName> 

    <ResultAttributeName>state</ResultAttributeName> 

    <ResultAttributeName>created_on</ResultAttributeName> 

    <ResultAttributeName>modified_on</ResultAttributeName> 

  </ResultAttributeNames> 

  <MaxResultToReturn>25</MaxResultToReturn> 

</RevisionQuerySettings> 

2.3 Aras 

2.3.1 ActionExtraAttributes 

Provide extra attributes for action call’s usable by customization in Aras Innovator. 

<ActionExtraAttributes enabled="true"> 

  <TypeAndAction type="Part" action="version"> 

    <ActionExtraAttribute>item_number</ActionExtraAttribute> 

    <ActionExtraAttribute>classification</ActionExtraAttribute> 

  </TypeAndAction> 

  <TypeAndAction type="CAD" action="version" getall="true"/> 

  <TypeAndAction type="Part" action="update"> 

    <ActionExtraAttribute>item_number</ActionExtraAttribute> 

    <ActionExtraAttribute>classification</ActionExtraAttribute> 

    <ActionExtraAttribute>name</ActionExtraAttribute> 

  </TypeAndAction> 

</ActionExtraAttributes> 

2.3.2 AdditionalLatestSearchAttributes 

List of search attributes, used to find the Latest Revision. 
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<AdditionalLatestSearchAttributes> 

 <SearchAttributes name=”is_released”>1</SearchAttributes> 

</AdditionalLatestSearchAttributes> 

2.3.3 CadInstanceNameAttributeName 

The attribute name for the CAD instance name at the BomInstance. The default is 

pwb_cad_instance_name. 

<CadInstanceNameAttributeName> 

  pwb_cad_instance_name 

</CadInstanceNameAttributeName> 

2.3.4 CADStructureClassification 

The classification of an CAD Structure relation, used for aux/nobom files. The default is Structure. 

<CADStructureClassification>Structure</CADStructureClassification> 

2.3.5 CADStructureImport 

ACI can create CAD Structure relations in addition to Part BOM relations when importing CAD data 

to Aras. Instance information (instance name, transformation matrix) will be copied from the Part 

BOM relation Disabled by default. 

<CADStructureImport enabled="true" /> 

If enabled, by default CAD Structure will be defined between: 

• Mechanical/Assembly (Parent) → Mechanical/Assembly (Child) 

• Mechanical/Assembly (Parent) → Mechanical/Part (Child) 

To define CAD Structure links between other CAD documents, configure the structure link: 

<CADStructureImport enabled="true"> 

  <StructureLink> 

    <Parent type="CAD" classification="Mechanical/Assembly" /> 

    <Child type="CAD" classification="Mechanical/Assembly" /> 

  </StructureLink> 

  <StructureLink> 

    <Parent type="CAD" classification="Mechanical/Assembly" /> 

    <Child type="CAD" classification="Mechanical/Part" /> 

  </StructureLink> 

</CADStructureImport> 

2.3.6 CatiaAuthoringExtension 

Extensions for which the the authoring_tool attribute is set to CATIA, the default is CATProduct, 

CATPart, CATDrawing, cgr and model. 
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<CatiaAuthoringExtension> 

  <Extension>CATProduct</Extension> 

  <Extension>CATPart</Extension> 

  <Extension>CATDrawing</Extension> 

  <Extension>cgr</Extension> 

  <Extension>model</Extension> 

</CatiaAuthoringExtension> 

2.3.7 ClassificationMapping 

Classification mapping for the transfer from V6 to Aras Innovator. 

Attributes for PartClassification:. 

• type: The Aras Innovator type, e.g. Part, CAD, etc. 

• tdpart: true if the Product is of a 3DPart. 

• tdxType (optional): The 3DEXPERIENCE type (property VPMLMType). 

• propName (optional): A property name from the xpdm xml. 

• propValue (optional): A property value from the xpdm xml. 

Attributes for DocumentClassification: 

• type: The Aras Innovator type, e.g. Part, CAD, etc. 

• filetype: The extension of the native file for the document. Can be empty 

• tdpart: true if the Product is of productType 3DPart. 

• tdxType (optional): The 3DEXPERIENCE type (property VPMLMType). 

• propName (optional): A property name from the xpdm xml. 

• propValue (optional): A property value from the xpdm xml. 

<ClassificationMapping> 

  <PartClassification type="Part" tdpart="false"> 

    /Part/Assembly 

  </PartClassification> 

  <PartClassification type="Part" tdpart="true"> 

    /Part/Component 

  </PartClassification> 

  <DocumentClassification type="CAD" filetype="CATPart"> 

    /CAD/Mechanical/Part 

  </DocumentClassification> 

  <DocumentClassification type="CAD" filetype="CATProduct" > 

    /CAD/Mechanical/Assembly 

  </DocumentClassification> 

  <DocumentClassification type="CAD" filetype="CATDrawing"> 

    /CAD/Mechanical/Drawing 

  </DocumentClassification> 

</ClassificationMapping> 
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2.3.8 DocumentFileAttributes 

Attributes which are handled as document file attributes. The default is native_file, neutral_file, 

viewable_file, view_file, and thumbnail. 

<DocumentFileAttributes> 

  <AttributeName>native_file</AttributeName> 

  <AttributeName>neutral_file</AttributeName> 

  <AttributeName>viewable_file</AttributeName> 

  <AttributeName>view_file</AttributeName> 

  <AttributeName>thumbnail</AttributeName> 

</DocumentFileAttributes> 

2.3.9 HandledTypes 

Types which are handled in Aras Innovator. default is Part, CAD, and File. This list must contain all 

types which should be handled in ACI. 

<HandledTypes> 

  <Type>Part</Type> 

  <Type>CAD</Type> 

  <Type>File</Type> 

<HandledTypes> 

2.3.10 LoadProperties 

The Aras Adapter handles and caches the Aras Innovator standard properties for performance 

issues. The preload of additional properties can be configured in the LoadProperties section. The 

PropertiesToLoad is type specific and must contain all properties which should be cached. The 

value is a comma separated list of properties to load. 

<LoadProperties> 

  <PropertiesToLoad type="Part"> 

    name,description,created_on,modified_on,state 

  </PropertiesToLoad> 

  <PropertiesToLoad type="BOM Instance"> 

    pwb_cad_instance_name,modified_on,sort_order, 

    pwb_transformation_matrix 

  </PropertiesToLoad> 

  <PropertiesToLoad type="CAD"> 

    description,state,modified_on,keyed_name,native_file, 

    viewable_file,view_file,thumbnail 

  </PropertiesToLoad> 

  <PropertiesToLoad type="File"> 

    modified_on,created_on,filename,file_size 

  </PropertiesToLoad> 

</LoadProperties> 
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2.3.11 StateList 

List of states representing a release state, the default is 'Released'. 

<StateList> 

  <State>Released</State> 

</StateList> 

2.3.12 TransformationMatrixAttributeName 

The attribute name for the transformation matrix at the BomInstance. The default is 

pwb_transformation_matrix. 

<TransformationMatrixAttributeName> 

  pwb_transformation_matrix 

</TransformationMatrixAttributeName> 

2.4 Enovia 

2.4.1 CustomAttributeMapping 

Define custom type and attributes that are exported from 3DEXPERIENCE or imported to 

3DEXPERIENCE. Disabled by default. 

A list of CustomObject definitions specifies the object types and their attributes. 

• type: 3DEXPERIENCE object type 

• mappingtype: intermediate mapping type to / from which the 3DEXPERIENCE object type 

is mapped 

• xname: 3DEXPERIENCE object class (Product, Rep3D, Drawing, Document, …) 

A CustomObject may contain multiple CustomAttribute. 

• name: 3DEXPERIENCE name of the attribute 

• extensionname: name of the attribute extension in 3DEXPERIENCE, if applicable 

• xname: intermediate mapping name of the attribute to / from which the 3DEXPERIENCE 

attribute is mapped 

• type: attribute type, one of string, boolean, dateTime, double, duration, integer or 

positiveInteger 

• export: true to export this attribute from Aras Innovator, default value is false 

• import: true to import this attribute from Aras Innovator, default value is true 

• core: true if this attribute should be mapped to a XPDMXML standard attribute on export or 

from a standard attribute on import. Default value is false. 

• basic: true if this 3DEXPERIENCE is a basic attribute not defined on an object type, for 

example type, description, physicalid. In ExportXpdm or ExportFiles mode these attributes 

will be exported from 3DEXPERIENCE. 

• maxlength: maximum length of the attribute 

• truncate: true to truncate attribute value if maxlength is exceeded 

• defaultValue: set a default value on Aras Innovator import if the attribute is empty 
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• unitConversionImport: to convert the attribute value to a different unit on 

3DEXPERIENCE import. Set attribute to name of a conversion as defined in 

UnitConversionDefinition (see 2.1.22). 

• xpdmExposed: false to export attributes from 3DEXPERIENCE that are not exposed with 

XPDM interface. These attributes are only exported if TDXExportMode is set to 

ExportXPDM. 

CustomAttributeMapping may also contain attribute flags to control if pdm-cust-config mapping 

files are generated for XPDM import or export – createPdmCustConfigForExport and 

createPdmCustConfigForImport. These mapping files control which attributes are exported or 

imported when transferring objects through XPDM interface and are generated from the 

CustomAttributeMapping. Alternatively, you can supply existing pdm-cust-config files with 

PdmCustConfigFileImport and PdmCustConfigFileExport. 

Following example defines the V_versionComment attribute for export of VPMReference types. 

<CustomAttributeMapping enabled="true" 

                        createPdmCustConfigForExport="true" 

                        createPdmCustConfigForImport="true"> 

  <CustomObject xname="Product" type="VPMReference"   

                mappingtype="VPMReference"> 

    <CustomAttribute xname="V_versionComment" name="V_versionComment"  

                     type="string" export="true" 

                     extensionname="MyExtension" /> 

  </CustomObject> 

</CustomAttributeMapping> 

2.4.2 EnableNonCatiaExpand 

Is only relevant if the TDXExportMode is set to ExportFiles. 

If set to true all geometries are exported, else only 3DPart geometries are exported. 

Default setting is false. 

<EnableNonCatiaExpand>false</EnableNonCatiaExpand> 

2.4.3 ExportWithStateFilter 

If enabled only objects with the configured state are exported from 3DEXPERIENCE. The value is a 

comma separated list of allowed states. 

<ExportWithStateFilter enabled="true"> 

  FROZEN,RELEASED 

</ExportWithStateFilter> 

2.4.4 FileExportConfiguration 

The configuration for the FileExport (TDXExportMode is set to ExportFiles) can be configured 

with FileExportConfiguration settings. 
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The FileExportConfiguration can be used to disable the CATPart or CATDrawing export. Also, 

Thumbnails or neutral formats can be exported. For detailed information about the configuration see 

the documentation of the Export batch in the “Readme_TSI3DXBatch.txt” file. 

The ignoreError flag can be set to true to ignore error at file export and continue processing.. 

The 3DXML export and the XCAD export can set the enableAssemblyCaching attribute to true 

to enable the Assembly file caching at export. 

RestApiExport defines exports with the Rest API from 3DEXPERIENCE.  

• AssemblyExport: enableExport set to false will skip the assembly file (POWER’BY) export. 

ignoreError set to true will continue on error. 

• PartExport: enableExport set to false will skip the part file (POWER’BY) export. 

ignoreError set to true will continue on error. 

• DrawingExport: enableExport set to false will skip the drawing file (POWER’BY) export. 

ignoreError set to true will continue on error. 

<FileExportConfiguration> 

  <Source type="3DShape"> 

    <CATPart enableExport="false"/> 

    <Thumbnail enableExport="true" viewableSize="300">PNG</Thumbnail> 

    <XCAD enableExport="false" xCadFormat="wrl">VRML</XCAD> 

    <XCAD enableExport="false" >JT_COMFOX</XCAD> 

  </Source> 

  <Source type="VPMReference"> 

    <TDXML enableExport="false" /> 

  </Source> 

  <Source type="Drawing"> 

    <CATDrawing enableExport="false"/> 

    <Thumbnail enableExport="true" viewableSize="300">PNG</Thumbnail> 

    <Print enableExport="true"/> 

  </Source> 

  <RestApiExport enabled="true"> 

    <AssemblyExport enableExport="true" ignoreError="true"/> 

    <PartExport enableExport="true" ignoreError="false"/> 

    <DrawingExport enableExport="true" ignoreError="true"/> 

  </RestApiExport> 

</FileExportConfiguration> 

2.4.5 GetMetadataSettings 

Defines the attributes which are returned from the “Show 3DEXPERIENCE Properties” command in 

the Aras Innovator Client. 

<GetMetadataSettings> 

  <ProductObject enoviaType="VPMReference"> 

    <AttributeName display="Type">type</AttributeName> 

    <AttributeName display="Name">name</AttributeName> 

    <AttributeName display="Revision">revision</AttributeName> 

    <AttributeName display="Vault">vault</AttributeName> 
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    <AttributeName display="Policy">policy</AttributeName> 

    <AttributeName display="State">current</AttributeName> 

    <AttributeName display="Created">originated</AttributeName> 

    <AttributeName display="Modified">modified</AttributeName> 

    <AttributeName display="Owner">owner</AttributeName> 

    <AttributeName display="Organization">organization</AttributeName> 

    <AttributeName display="Project">project</AttributeName> 

    <AttributeName display="External ID"> 

      attribute[PLMEntity.PLM_ExternalID]</AttributeName> 

    <AttributeName display="Title"> 

      attribute[PLMEntity.V_Name]</AttributeName> 

    <AttributeName display=""> 

      attribute[PLMEntity.V_description]</AttributeName> 

  </ProductObject> 

</GetMetadataSettings> 

2.4.6 OverwriteOriginal 

Disable to not overwrite original data (after CLOC) in 3DEXPERIENCE. Enabled by default. 

<OverwriteOriginal>false</OverwriteOriginal> 

2.4.7 QuerySettings 

The ACI integration inside Aras Innovator provides an online query in 3DEXPERIENCE without 

changing the application. Based on the query result a data transfer from 3DEXPERIENCE to Aras 

Innovator can be initiated.  

The corresponding configurations for the query in 3DEXPERIENCE are defined in the 

QuerySettings section. 

DefaultEnoviaRole and the DefaultEnoviaVault are used as defaults for the 

3DEXPERIENCE login. The configured values are presented in the 3DEXPERIENCE login dialog 

window and can be modified by the user. If no default values are configured, empty input fields are 

presented to the user. 

QueryLimit defines the maximum number of query results presented to the user. If more matching 

objects are available in 3DEXPERIENCE, an information message will appear inside the user 

interface. The default setting is “100”. 

QueryTypes defines a list of selectable object types for the 3DEXPERIENCE query. Each 

QueryType defines one 3DEXPERIENCE object type (3DEXPERIENCE internal type name). The 

display attribute defines the type name presented to the user. If no query type is configured, an 

empty input field is presented to the user. In this case, the user has to input the 3DEXPERIENCE 

internal type name, like “VPMReference”. 

QueryAttributes defines the 3DEXPERIENCE attributes, which will be presented in the result 

table. The order of the attributes in the result table is also defined here and corresponds to the 

attribute sequence. Each QueryAttribute defines one 3DEXPERIENCE attribute, e.g. 

“majorrevision”. The display attribute defines a corresponding name used in the results window, 

e.g. “Major Revision”. If the visible attribute is set to “false”, the 3DEXPERIENCE attribute will not 
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be visible inside the result window. The default for the visible attribute is “true”. If no query 

attributes are configured, a list of default attributes is used. 

<QuerySettings> 

  <DefaultEnoviaRole>VPLMProjectLeader.Company Name.Common 

Space</DefaultEnoviaRole> 

  <DefaultEnoviaVault>vplm</DefaultEnoviaVault> 

  <QueryLimit>200</QueryLimit> 

  <QueryTypes> 

    <QueryType display="Physical Product">VPMReference</QueryType> 

  </QueryTypes> 

  <QueryAttributes> 

    <QueryAttribute display="Identification code" visible="true"> 

      id 

    </QueryAttribute> 

    <QueryAttribute display="Type" visible="true"> 

      type 

    </QueryAttribute> 

    <QueryAttribute display="Name" visible="true"> 

      name 

    </QueryAttribute> 

    <QueryAttribute display="Revision" visible="true"> 

      revision 

    </QueryAttribute> 

    ... 

  </QueryAttributes> 

</QuerySettings> 

2.4.8 RemoveNon3DPartRep3D 

True to remove Rep3D/Rep3DInst and Rep3DAggr from the XPDM export which are not connected 

with a 3DPart. 

<RemoveNon3DPartRep3D>false</RemoveNon3DPartRep3D> 

2.5 Features 

Enable or disable features if not required by use case. For example, in case of unidirectional transfer 

from 3DEXPERIENCE to Aras Innovator only, disable Aras Innovator to 3DEXPERIENCE 

functionality. 

• SendTo3DX: transferring Parts to 3DEXPERIENCE. Default is enabled. 

• SendToPDM: transferring Physical Product to Aras Innovator. Default is enabled. 

• ListTo3DX: transfer lists of Parts to 3DEXPERIENCE. Default is enabled. 

• ListToPDM: transfer lists of Physical Products to Aras Innovator. Default is enabled. 

• StructureCompare: compare transferred objects between Aras Innovator and 

3DEXPERIENCE. Default is enabled. 
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• ReviseIn3DX: revise transferred objects in 3DEXPERIENCE without transferring 

structure. Default is disabled. 

• MetaUpdateIn3DX: synchronize attributes from Aras Innovator to 3DEXPERIENCE 

without transferring structure. Default is disabled. 

• Query3DXPhysicalProduct: search for Physical Products in 3DEXPERIENCE. Default 

is enabled. 

• QueryPDMPartRevision: search for Parts in Aras Innovator. Default is enabled. 

• DetailsServlet: show Aras Innovator or 3DEXPERIENCE object details based on 

object UID in Tools -> Details. Default is disabled. 

• FileCacheInfoServlet: show file cache entries in Tools ->File Cache. Use maxReturn 

to control how many results are shown. Default is disabled. 

• JobServlet: show information about submitted jobs in Tools -> Job. Default is disabled. 

• TableInfoServlet: query ACI Product and Document table in Tools -> Table Info. 

Default is disabled. 

<Features> 

 <SendTo3DX enabled="true"/> 

 <SendToPDM enabled="true"/> 

 <ListTo3DX enabled="true"/> 

 <ListToPDM enabled="true"/> 

 <StructureCompare enabled="true"/> 

 <ReviseIn3DX enabled="false"/> 

 <MetaUpdateIn3DX enabled="false"/> 

 <Query3DXPhysicalProduct enabled="true"/> 

 <QueryPDMPartRevision enabled="true"/> 

 <DetailsServlet enabled="false"/> 

 <FileCacheInfoServlet enabled="true" maxReturn="50"/> 

 <JobServlet enabled="true"/> 

 <TableInfoServlet enabled="true"/> 

</Features> 
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3 Administration settings 

The file XCIAdminSettings.xml in XCI_HOME defines administration settings for the integration, 

for example connection parameters to Aras Innovator and 3DEXPERIENCE. 

It is divided into sections: 

• Administration: settings defining integration behavior 

• Pdm: settings for Aras Innovator behavior 

• Aras: specific settings Aras Innovator 

• Enovia: specific settings for 3DEXPERIENCE 

• XciWeb: settings for the ACI web client 

• Scheduler: settings for scheduling automated processes 

• TSI3DXBatch: configuration of 3DEXPERIENCE import and export batch utility 

• COMReconV5: configuration of CATIA V5 pre- and postprocessing 

• FileConversion: configuration of file conversion batches 

The next subchapters list settings available in these sections. 

3.1 Administration 

3.1.1 CleanupPersistentDir 

True to clean up the persistent directory when the content is successfully transferred. Disabled by 

default. 

<CleanupPersistentDir>true</CleanupPersistentDir> 

3.1.2 CleanupReportDirDaysToKeep 

Define how many days to keep the reports in the Report directory. Default is -1 meaning results are 

kept indefinitely. 

<CleanupReportDirDaysToKeep>30</CleanupReportDirDaysToKeep> 

3.1.3 ConversionServerLoadBalancer 

Control behavior for the Conversion Server load balancer.  

• Timeout: timeout in seconds to wait for a free Conversion Server if all are in use. If timeout 

is reached, without receiving a free Conversion Server, the process is terminated with error. 

Default is 0 meaning unlimited timeout. 

• Taskkill: command to kill running processes on CS when processes are canceled. 

Enabled by default and default command is “taskkill /F /PID ___PID___” where ___PID___ 

represents the system process ID. 

<ConversionServerLoadBalancer> 

  <Timeout>3600</Timeout> 

  <Taskkill enabled=”true”> 
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    <Command>taskkill /F /PID ___PID___</Command> 

  </Taskkill> 

</ConversionServerLoadBalancer> 

3.1.4 Customizations 

The behavior of the integration can be modified using customization points. The Customizations 

tag may contain multiple CustomizationPoints defining which customization implementation 

should be used. Each CustomizationPoint defines a custpoint to be overridden and an 

entrypoint specifying the overriding implementation. The optional attribute enabled has the 

default true. 

If you require any kind of customization, please contact the support team. 

<Customizations> 

  <CustomizationPoint  

    custpoint="com.tsystems.xci.customization.CustomizationPointX" 

    entrypoint="my.customization.MyCustomizationPointImpl" /> 

</Customizations> 

3.1.5 Database 

ACI makes use of a database to store and keep track of required data. The used database must be 

configured using the resource definition of the application server. ACI will read the resource defined 

as jdbc/xciDB.  

The resource must be configured at the Tomcat application server in 

<CATALINA_HOME>/conf/context.xml. The default resource can be overridden by defining 

the PersistenceUnitName. 

<Database> 

  <PersistenceUnitName>jdbc/myXciDB</PersistenceUnitName> 

</Database> 

Example resource definition for Oracle: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  

 auth="Container" driverClassName="oracle.jdbc.OracleDriver"  

 maxTotal="100" maxIdle="10" maxWaitMillis="-1" 

 url="jdbc:oracle:thin:@my.db-server-url.com:1521:orcl"  

 username="XCI"  

 password="XCI" /> 

Example resource definition for MS SQL: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  

 auth="Container"     

     driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  

 maxTotal="100" maxIdle="10" maxWaitMillis="-1" 

 url="jdbc:sqlserver://my.db-server-url.com\SQLEXPRESS; 

          databaseName=XCI"  
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 username="XCI"  

 password="XCI" /> 

Example resource definition for H2: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  

 auth="Container" driverClassName="org.h2.Driver"  

 maxTotal="100" maxIdle="10" maxWaitMillis="-1"  

 url="jdbc:h2:C:\XCI\XCI_HOME\xciDB\xciDB;AUTO_SERVER=TRUE"  

 username="XCI"  

 password="XCI" /> 

 

If the resource is not defined at the application server, a local and file based H2DB will be created in 

XCI_HOME directory. 

3.1.6 DwcProductStructureExport 

Export product structure with DownwardComaptibilty batch (export CATPart and CATProduct files 

from 3DEXPERIENCE with one call). Disabled by default. 

<DwcProductStructureExport enabled="true" /> 

3.1.7 ImportPdm 

Strategy how to import the 3DEXPERIENCE structures to Aras Innovator: 

• enableLevelSplitUp: true will enable the split up of the Aras Innovator import in a level-

based import. Disabled by default. 

• enableLevelSetBased: true will enable the set-based approach for the import of one level. 

The level-based import will start at the deepest level nodes of the product structure and will 

first import these leave nodes, then the parent objects up to the top level are imported 

including the direct children. If enableLevelSetBased is set to true then the same levels 

are imported in one import process (using the set-based import), else each object is imported 

in its own import process. Disabled by default. 

• enableQueuing: true will enable the functionality to not handle the same part number in 

parallel running Aras Innovator imports. Disabled by default. 

• timeoutQueuing: timeout for the import queuing in ms. Default value is 10 minutes. 

• enableLevelQueuing: true will enable the functionality to not handle the same part 

number in parallel running Aras Innovator level imports. Disabled by default. 

• timeoutLevelQueuing: timeout for the import queuing in ms. Default value is 10 minutes. 

<ImportPdm enableLevelSplitUp="true"  

           enableLevelSetBased="false"  

           enableQueuing="false"  

           timeoutQueuing="600000"  

           enableLevelQueuing="true"  

           timeoutLevelQueuing="600000" /> 
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3.1.8 JobDatabaseRefreshInterval 

Interval to query the database for new transfer jobs in in ms. Default value is 5 seconds. 

<JobDatabaseRefreshInterval>10000</JobDatabaseRefreshInterval> 

3.1.9 JobReceiverComplexThreadPoolSize 

The size of the Job Receiver complex thread pool (used for folder or list transfers). Restart needed 

to use the new value. Default value is 3. 

<JobReceiverComplexThreadPoolSize>6</JobReceiverComplexThreadPoolSize> 

3.1.10 JobReceiverThreadPoolSize 

The size of the Job Receiver thread pool. Restart needed to use the new value. Default value is 5. 

<JobReceiverThreadPoolSize>10</ JobReceiverThreadPoolSize> 

3.1.11 JobRetrySeconds 

The number of seconds to wait for the Job retry if the job fails. 0 will disable the retry. Default is 30 

seconds. 

<JobRetrySeconds>0</JobRetrySeconds> 

3.1.12 JobSchedulingStrategy 

Strategy which selects the next Job to run. Whenever there is free capacity in the job queue, this 

strategy reads queued jobs from the database and determines the next to job to run. Supported 

strategies: 

• FIFO: jobs are run in a first-in, first-out fashion, i.e. jobs are sorted by creation date and the 

oldest jobs is selected to run. Default strategy. 

• RoundRobin: jobs are separated into buckets. ACI then alternates between the buckets 

whenever there is a job to run. Jobs are divided into 

o one bucket for all standard job submitted by client (web client, Aras or 

3DEXPERIENCE client plugin) 

o one bucket for each complex jobs (List, Folder, …) – all child jobs of one complex job 

are grouped into the same bucket 

o one bucket for jobs started by the scheduler 

<JobSchedulingStrategy>RoundRobin</JobSchedulingStrategy> 

3.1.13 LegacyTransformationSupport 

Enables the support for legacy transformation in Aras Innovator. Enabled by default. 

<LegacyTransformationSupport enabled="true" /> 
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3.1.14 PersistentDir 

Optional definition of a directory to be used by ÁCI to store persistent data. ACI must have read and 

write access to this directory.  

If the value is not defined the path <XCI_HOME>\persistent will be used. 

<PersistentDir>C:\persistent</PersistentDir> 

3.1.15 PdmDocumentRevisionMapping 

Defines the revision numbers in Aras Innovator for 3DEXPERIENCE representations. 

If PdmDocumentRevisionMapping is configured, ACI will perform a direct assignment between 

the revisions of Aras Innovator and 3DEXPERIENCE. As a result of this configuration, the revisions 

in Aras Innovator or 3DEXPERIENCE may have gaps if only selected revisions are transferred. 

• alphabetical: revisions in Aras Innovator are alphabetical (A, B, C, …) 

• numerical: revisions in Aras Innovator are numerical (1, 2, 3, …) 

• system: use revision sequence associated with type in Aras Innovator 

If the PdmDocumentRevisionMapping is not configured the next free revision/index will be used, 

based on ACI mapping. As a result, revisions in the target system are in the order in which they are 

transferred which may not be the order in the source system. 

<PdmDocumentRevisionMapping>alphabetical</PdmDocumentRevisionMapping> 

3.1.16 PdmRevisionMapping 

Defines the revision numbers in Aras Innovator. 

If PdmRevisionMapping is configured, ACI will perform a direct assignment between the revisions 

of Aras Innovator and 3DEXPERIENCE. As a result of this configuration, the revisions in Aras 

Innovator or 3DEXPERIENCE may have gaps if only selected revisions are transferred. 

• alphabetical: revisions in Aras Innovator are alphabetical (A, B, C, …) 

• numerical: revisions in Aras Innovator are numerical (1, 2, 3, …) 

• system: use revision sequence associated with type in Aras Innovator 

If the PdmRevisionMapping is not configured the next free revision/index will be used, based on 

ACI mapping. As a result, revisions in the target system are in the order in which they are transferred 

which may not be the order in the source system. 

<PdmRevisionMapping>alphabetical</PdmRevisionMapping> 

3.1.17 ProcessStatusMaxDuration 

The search period used to search for ProcessStatus information when retrieving process status from 

client plugins. Default value is P7D to retrieve info for the last seven days. 

<ProcessStatusMaxDuration>P7D</ProcessStatusMaxDuration> 
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3.1.18 ProcessStatusMaxReturn 

The maximum number of ProcessStatus information to return when retrieving process status from 

client plugins. Default value is 50. 

<ProcessStatusMaxReturn>50</ProcessStatusMaxReturn> 

3.1.19 ProcessStatusOnlySessionUser 

Filter the result of the ProcessStatus by the current session user when retrieving process status from 

client plugins. Enabled by default. 

<ProcessStatusOnlySessionUser>true</ProcessStatusOnlySessionUser> 

3.1.20 ResourceBalancer 

Limits concurrent use of resources across all Converter Server hosts. A resource can be licenses 

for example and is identified by a string.  

The resource must then be assigned to a batch type, see 3.7 for TSI3DXBatch, 3.8 for COMReconV5 

and 3.9 for file conversion. 

<ResourceBalancer> 

  <Resource name=”V6” maxParallel=”2” /> 

  <Resource name=”V5” maxParallel=”2” /> 

</ResourceBalancer> 

3.1.21 SetFilterIn3DX 

True to enable the functionality to set filter in 3DX when sending structure names. Enabled by default. 

<SetFilterIn3DX>true</SetFilterIn3DX> 

3.1.22 SkipRepWithoutFile 

True to remove Representations without file -> no document without file. Disabled by default. 

<SkipRepWithoutFile>false</SkipRepWithoutFile> 

3.1.23 TDXExportMode 

The 3DEXPERIENCE export mode can be configured. 

• ExportXPDM: export from 3DEXPERIENCE using the XPDMImportExportBatch utility. On 

Premise only. 

• ExportFiles: export from 3DEXPERIENCE using Matrix and DWC utility. On Premise 

only. 

• ExportDesign: export from 3DEXPERIENCE using web services and DWC utility. 

• ExportStepx: export from 3DEXPERIENCE using the Enterprise IP Exchange service. 

Cloud only. 
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Default value is ExportFiles. 

<TDXExportMode>ExportXPDM</TDXExportMode> 

3.1.24 TDXImportMode 

The 3DEXPERIENCE import mode can be configured. 

• ImportXPDM: import to 3DEXPERIENCE using the XPDMImportExportBatch utility. On 

Premise only. 

• ImportStepx: import to 3DEXPERIENCE using the Enterprise IP Exchange service. Cloud 

only. 

Default value is ImportXPDM. 

<TDXImportMode>ImportXPDM</TDXImportMode> 

3.1.25 TempDir 

Optional definition of a temporary directory to be used by ACI. ACI must have read and write access 

to this directory. 

If the value is not defined the path <XCI_HOME>\temp will be used. 

<TempDir>C:\temp</TempDir> 

3.1.26 UidAsFileName 

Define if filenames of files exported by Aras Innovator should be renamed to their Aras Innovator uid 

+ file extension. Files in different datasets in Aras Innovator may have the same filename which can 

lead to collisions. 

If the setting does not exist, no files will be renamed. 

If rename is true, then all files will be renamed except files with extension specified in 

ExcludeFileExtension. 

If rename is false, only files with extension specified in ExcludeFileExtension will be renamed. 

<UidAsFileName rename=”true”> 

  <ExcludeFileExtension>CATPart</ExcludeFileExtension> 

  <ExcludeFileExtension>CATProduct</ExcludeFileExtension> 

</UidAsFileName> 

3.1.27 XCIServerUrl 

URL of ACI integration webapp. Must be configured if distributed Conversion Server are used, so 

that they can communicate back to ACI. 

<XCIServerUrl>https://my-aci-server:8080/XCI</XCIServerUrl> 
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3.2 Pdm 

3.2.1 Dispatchers 

Definitions for optional dispatchers to use. Each dispatcher can be enabled separately. 

<Dispatchers> 

  <Dispatcher enabled="true"> 

    <DocumentType>CAD</DocumentType> 

    <FileType>CATIA Part</FileType> 

    <Provider/ > 

    <Priority>0</Priority> 

    <Servicename>Aras 3D CAD to PDF Conversion</Servicename> 

  </Dispatcher> 

</Dispatchers> 

3.2.2 ExpandChunkSize 

Define how many objects to expand per Aras Innovator call. Default value is 1000. 

Warning: can affect the performance of the tool and die utilization of the Aras Innovator server. 

<ExpandChunkSize>1000</ExpandChunkSize> 

3.2.3 FileDownloadChunkSize 

Define how many files to download per request from Aras Innovator. Default value is 1. 

<FileDownloadChunkSize>1</FileDownloadChunkSize> 

3.2.4 FileUploadChunkSize 

Define how many files to upload per request from Aras Innovator. Default value is 1. 

<FileUploadChunkSize>1</FileUploadChunkSize> 

3.2.5 GetPropertiesChunkSize 

Define for how many objects to retrieve properties per Aras Innovator call. Default value is 1000. 

Warning: can affect the performance of the tool and die utilization of the Aras Innovator server. 

<GetPropertiesChunkSize>1000</GetPropertiesChunkSize> 

3.2.6 HoldConnectionOpenInSeconds 

Seconds to keep the Aras Innovator service connection open while waiting for new service 

connection request. Default value is 60 seconds. 

<HoldConnectionOpenInSeconds>60</HoldConnectionOpenInSeconds> 
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3.2.7 RefreshChunkSize 

Define how many objects to refresh per Aras Innovator call. Default value is 1000. 

Warning: can affect the performance of the tool and die utilization of the Aras Innovator server. 

<RefreshChunkSize>1000</RefreshChunkSize> 

3.2.8 SendJobNotifications 

Enable to send user a message in the Aras Innovator notification system after the Job is finished. 

The width and height setting can be used to format the width and height of the notification 

window. 

If the configured Aras Innovator User does not belong to the “Administrators” Identity, the user must 

be added to the Identities list that “Can Add” a Message to allow the ACI integration user the creation 

of Message Notifications. 

 

<SendJobNotifications enabled="true"> 

  <JobNotificationSetting name=”width”>300</JobNotificationSetting> 

  <JobNotificationSetting name=”height”>300</JobNotificationSetting> 

</SendJobNotifications> 

3.2.9 TemplateProductImport 

The location of the template product file to use on import. The product file will be added on Aras 

Innovator imports. The location may be relative to the XCI_HOME directory or an absolute path. 

<TemplateProductImport enabled="true"> 

  TemplateProduct.CATProduct 

</TemplateProductImport> 
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3.3 Aras 

3.3.1 DeleteOrphanFilesAtUpdate 

True to delete old, no longer referenced files after update of a File in Aras. The default is true. 

<DeleteOrphanFilesAtUpdate>false</DeleteOrphanFilesAtUpdate> 

3.3.2 HTTPClient 

Define HTTP connection settings when connecting to Aras: 

• ConnectionRequestTimeout: timeout in milliseconds when requesting a connection from 

connection pool. Default: 15000. Set to 0 for no timeout and to negative to use system default. 

• ConnectTimeout: timeout in milliseconds until connection is established. Default: 15000. 

Set to 0 for no timeout and to negative to use system default. 

• SocketTimeout: timeout in milliseconds between two consecutive data packages. Default: 

50000. Set to 0 for no timeout and to negative to use system default. 

<HTTPClient> 

  <ConnectionRequestTimeout>15000</ConnectionRequestTimeout> 

  <ConnectTimeout>15000</ConnectTimeout > 

  <SocketTimeout>50000</SocketTimeout> 

</HTTPClient> 

3.3.3 PWBCompatibility 

To switch on the PWB compatibility mode the following configurations must be set in the ACI 

configuration file in the Aras section. 

• ExpandNonBomGeo: true to expand non bom geometry files for PWB. Default value is true. 

<PWBCompatibility enabled="true"> 

  <ExpandNonBomGeo>true</ExpandNonBomGeo> 

</PWBCompatibility> 

3.3.4 Server 

Definition of the Aras Innovator server and the login credentials of the ACI user. 

• Username: username of Aras Innovator user 

• Password: password for user, encrypted by default (see installation manual for password 

encryption). Set plaintext flag to use password without encryption. 

• Database: name of Aras Innovator database to connect to 

• Vault: name of Aras Innovator vault to use 

• Locale: optional, locale for the user 

• UseAccessToken: optional, true to use token based authentication from Aras 12 onwards. 

Default value is true. 

• AlgorithmForHash: can be set MD5 or SHA-256. Default value is MD5.  

<Server> 
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  <Url> 

    http://my.aras-server.url:8080/InnovatorServer/Server/ 

    InnovatorServer.aspx 

  </Url> 

  <Username>myACIUser</Username> 

  <Password>myACIPassword</Password> 

  <Database>InnovatorSolutions</Database> 

  <Vault>Default</Vault> 

  <UseAccessToken>true</UseAccessToken> 

  <AlgorithmForHash></AlgorithmForHash> 

</Server> 

3.4 Enovia 

3.4.1 BulkOperation 

Specific operations can be parallelized by running multiple threads. Define how many threads can 

be started in parallel for: 

• VPMReferenceQueryParallelSize: query for VPMReference objects. Default is 1 

because ADK seems to serialize the queries and there would be a performance loss due to 

overhead. For REST / Cloud this should be set to a higher value (e.g. 20). 

<BulkOperation> 

 <VPMReferenceQueryParallelSize>1</VPMReferenceQueryParallelSize> 

</BulkOperation > 

3.4.2 CatiaV5ExportVersion 

The CATIA V5 version used to store the info in Aras Innovator. 

<CatiaV5ExportVersion>V5R28</CatiaV5ExportVersion> 

3.4.3 ChildObjectExpandPattern 

Optional expand pattern for child part objects. Comma separated list of types. Default setting is 

“VPMReference”. 

<ChildObjectExpandPattern>VPMReference</ChildObjectExpandPattern> 

3.4.4 ChildRelationExpandPattern 

Optional expand pattern for child relations. Comma separated list of relation types. Default setting is 

“VPMInstance”. 

<ChildRelationExpandPattern>VPMInstance</ChildRelationExpandPattern> 



Administration  settings Enovia 

ACI Release 3.14 - Settings Reference 37 

3.4.5 Customization 

Definition of the customization to use in XPDM events. This customization must be defined in the 

pdm-cust-config.xml in the 3DEXPERIENCE installation. 

The com.tsystems.xci.customization.CustomTypeMapping customization class can 

overwrite this setting. 

<Customization>DefaultCustomization</Customization> 

3.4.6 DocumentDisplayPattern 

Display pattern for documents. Default setting is “{name} {revision}”. 

<DocumentDisplayPattern>{name} {revision}</VPMReferenceDisplayPattern> 

3.4.7 ExportStep 

Settings for the Stepx export from 3DEXPERIENCE cloud by the Enterprise IP Exchange service. 

• ExportJobPollingSleepPeriod: time in milliseconds to wait between job result polling. 

Default is 10000 (10 seconds). 

• ExportJobMaximumDuration: time in minutes to wait for the job result. 0 or negative for 

infinite. Default is 60. 

<ExportStep> 

 <ExportJobPollingSleepPeriod>10000</ExportJobPollingSleepPeriod> 

 <ExportJobMaximumDuration>60</ExportJobMaximumDuration> 

</ExportStep> 

 

3.4.8 FileCache 

Defines the File Cache URL used to cache files for the export files mode. Disabled by default. 

<FileCache enabled="true"> 

  <XciFcUrl>http://my.aci-integration-server.url:port/XCI_FC</XciFcUrl> 

</FileCache> 

3.4.9 HoldConnectionOpenInSeconds 

Seconds to keep the 3DEXPERIENCE service connection open while waiting for new service 

connection request. The default value is 60. 

<HoldConnectionOpenInSeconds>60</HoldConnectionOpenInSeconds> 

3.4.10 HTTPClient 

Define HTTP connection settings when connecting to 3DEXPERIENCE: 
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• ConnectionRequestTimeout: timeout in milliseconds when requesting a connection from 

connection pool. Default: 15000. Set to 0 for no timeout and to negative to use system default. 

• ConnectTimeout: timeout in milliseconds until connection is established. Default: 15000. 

Set to 0 for no timeout and to negative to use system default. 

• SocketTimeout: timeout in milliseconds between two consecutive data packages. Default: 

50000. Set to 0 for no timeout and to negative to use system default. 

<HTTPClient> 

  <ConnectionRequestTimeout>15000</ConnectionRequestTimeout> 

  <ConnectTimeout>15000</ConnectTimeout > 

  <SocketTimeout>50000</SocketTimeout> 

</HTTPClient> 

3.4.11 ImportPowerBy 

Enable to activate 3DEXPERIENCE import in POWER'BY mode. Data will be imported in native V5 

format into 3DEXPERIENCE and can then be loaded using the Dassault POWER'BY Integration of 

3DEXPERIENCE and V5. Disabled by default. 

<ImportPowerBy enabled="true" /> 

3.4.12 ImportStep 

Settings for the Stepx import to 3DEXPERIENCE cloud by the Enterprise IP Exchange service. 

• ImportCompanyName: company name for the STEP header. Default is "T-Systems 

International GmbH". 

• ImportCompanyId: company id for the STEP header. Default is "www.t-systems.com". 

• ImportJobPollingSleepPeriod: time in milliseconds to wait between job result polling. 

Default is 10000. 

• ImportJobMaximumDuration: time in minutes to wait for the job result. Default is 30. 

• ImportJobMaximumDurationResultsInError: true to set the job result to success if it 

runs longer than the ImportJobMaximumDuration. Default is true.  

• EnableNon3DPartGeometryImport: true to enable the import of non 3DPart geometries, 

e.g. cgr, V4 model. 

<ImportStep> 

  <ImportCompanyName>My Company name</ImportCompanyName 

  ... 

</ImportStep> 

3.4.13 MappingContextName 

The mapping context name to use, used to find the correct mapping in 3DEXPERIENCE. 

<MappingContextName>XPDM<MappingContextName> 
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3.4.14 RepObjectExpandPattern 

Optional expand pattern for representation objects. Comma separated list of types. Default setting 

is “VPMRepReference”. 

<RepObjectExpandPattern>VPMRepReference</RepObjectExpandPattern> 

3.4.15 RepRelationExpandPattern 

Optional expand pattern for representation relations. Comma separated list of relation types. Default 

setting is “VPMRepInstance”. 

<RepRelationExpandPattern>VPMRepInstance</RepRelationExpandPattern> 

3.4.16 RestApiUseOneSearchField 

True to use only one untyped search field for the 3DEXPERIENCE search in the web client. 

<RestApiUseOneSearchField>true</RestApiUseOneSearchField> 

3.4.17 SecurityContextTranslation 

The ACI Aras Innovator client plugin provides a 3DEXPERIENCE login enhancement to select a 

security context in 3DEXPERIENCE based on Role, Organization, and Collaborative space. The 

display values for Role, Organization and Collaborative Space can be configured to translate internal 

names to user friendly ones. 

<SecurityContextTranslation> 

 <Role name="VPLMAdmin" display="Administrator"/> 

 <Role name="VPLMCreator" display="Author"/> 

 <Role name="VPLMExperimenter" display="Contributor"/> 

 <Role name="VPLMProjectAdministrator" display="Owner"/> 

 <Role name="VPLMProjectLeader" display="Leader"/> 

 <Role name="VPLMViewer" display="Reader"/> 

 <Role name="VPLMSecuredCrossAccess" display="Public Reader"/> 

 <Role name="VPLMAdmin" display="Administrator"/> 

</SecurityContextTranslation> 

3.4.18 Server 

Define 3DEXPERIENCE server connection. Parameters may be different for On Premise or Cloud 

deployment. 

Connecting to On Premise: 

• webServiceOnly: flag to connect only with web services. Disabled by default. 

• SpaceUrl: 3DSpace URL 

• PassportUrl: 3DPassport URL 

• Username: username for connecting to 3DEXPERIENCE 
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• Password: password for connecting to 3DEXPERIENCE, encrypted by default (see 

installation manual for password encryption). Set plaintext flag to use password without 

encryption. 

• SecurityContext: Security Context for connecting to 3DEXPERIENCE provided as 

Role.Organization.CollaborativeSpace (e.g. VPLMProjectLeader.Company Name.Common 

Space) 

• Vault: optional, vault to set on connection 

• Use3DPassport: optional, false if connecting to internal 3DSpace. Enabled by default. 

• Environment: optional, 3DEXPERIENCE to use when connecting with batch utilities. 

Default value is UnifiedTyping. 

Connecting to Cloud: 

• webServiceOnly: flag to connect only with web services. Must be set to true. 

• SpaceUrl: 3DSpace URL 

• PassportUrl: 3DPassport URL 

• Username: username for connecting to 3DEXPERIENCE 

• Password: password for connecting to 3DEXPERIENCE, encrypted by default (see 

installation manual for password encryption). Set plaintext flag to use password without 

encryption. 

• SecurityContext: Security Context for connecting to 3DEXPERIENCE provided as 

Role.Organization.CollaborativeSpace (e.g. VPLMProjectLeader.Company Name.Common 

Space) 

• Tenant: must be set to the Cloud tenant ID 

• ExchangeUrl: optional, URL of Enterprise IP Integration framework, must be set 

exchanging Stepx with the Cloud. 

• Language: optional, language in which attribute names are returned by 3DEXPERIENCE 

web services. Default language is en. 

• IndexSearchRetryCount: optional, number of retries when creating Variant and Options 

in case they are not indexed yet. Set flag firstRetryDelay to delay first retry in 

milliseconds (default is 10000). Set flag interval to define interval between retries in 

milliseconds (default is 60000). 

• Environment: optional, 3DEXPERIENCE to use when connecting with batch utilities. 

Default value is UnifiedTyping. 

Example for connection to On Premise 3DEXPERIENCE: 

<Server webServiceOnly=”false”> 

 <SpaceUrl>https://space-server.url:port/3dspace</SpaceUrl> 

     <PassportUrl> 

       https://passport-server.url:port/3dpassport 

      </PassportUrl> 

 <Username>user</Username> 

 <Password>XXX</Password> 

 <SecurityContext> 

       VPLMProjectLeader.Company Name.Common Space 

     </SecurityContext> 

 <Vault>vplm</Vault> 

</Server> 
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3.4.19 SessionTimeout 

Defines the timeframe of inactivity in the 3DEXPERIENCE session before a relogin is done in the 

next operation in the session. Default value is 30 minutes. 

<SessionTimeout enabled="true">30</SessionTimeout> 

3.4.20 VPMReferenceDisplayPattern 

Display pattern for VPMReference (Physical Products). Default value is 

“{attribute[PLMEntity.PLM_ExternalID]} {revision} {attribute[PLMEntity.V_Name]}”. 

<VPMReferenceDisplayPattern>{attribute[PLMEntity.PLM_ExternalID]} 

{majorrevision}</VPMReferenceDisplayPattern> 

3.5 XciWeb 

3.5.1 AdminPassword 

Admin password for ACI web client. For password encryption, please see installation manual. 

Password must be encrypted by default. 

<AdminPassword plaintext="true">XXX</AdminPassword> 

3.5.2 MaxDBReturnNumber 

The maximum number of objects returned for the DB queries. Default value is 25. 

<MaxDBReturnNumber>50</MaxDBReturnNumber> 

3.5.3 MaxQueryReturnNumber 

The maximum number of objects returned for the 3DEXPERIENCE and Aras Innovator queries. 

Default value is 25. 

<MaxQueryReturnNumber>50</MaxQueryReturnNumber> 

3.5.4 SessionTimeout 

The session timeout in seconds used for the ACI web client. Default timeout is 1800 seconds. 

<SessionTimeout>2000</SessionTimeout> 

3.5.5 UseFluid 

Use full display width for ACI web client. Disabled by default. 

<UseFluid>true</UseFluid> 
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3.6 Scheduler 

Scheduler can be used to automatically run processes at defined intervals. Disabled by default. 

• ThreadPoolSize: initializes the size of the Scheduler thread pool. Default is 5, minimum is 

3. A restart is needed to use the new value. 

• StartupDelay: defines the startup delay for tasks without startTime setting in seconds. 

Default is 60 seconds. 

• TaskList: list of tasks to run. ACI includes two tasks, HandleReleasedPdmObjects and 

HandleReleasedEnoviaObjects, which are described in following sections. 

<Scheduler enabled="true"> 

  <ThreadPoolSize>5</ThreadPoolSize> 

  <StartupDelay>120</StartupDelay> 

  <TaskList> 

    <Task>...</Task> 

    ... 

  </TaskList> 

</Scheduler> 

TaskList contains a list of Task objects to be run with the scheduler. 

Task contains a list of common control flags and a set of TaskSetting specific for each task. 

• enabled: true to run the task. 

• name: unique name of the Task. 

• loadClass: class to use which implements task logic 

• startTime: the start time of the task, e.g. "14:12:00". 

• period: the period in seconds to wait for next start of the task. 

• type: the scheduler type FixedRate or FixedDelay 

o FixedRate: enabled first after the given initial delay, and subsequently with the given 

period. 

o FixedDelay: enabled first after the given initial delay, and subsequently with the 

given delay between the termination of one execution and the commencement of the 

next. 

3.6.1 HandleReleasedPdmObjects 

The HandleReleasedPdmObjects task queries for objects with a defined state in Aras Innovator. 

If the found revision is a new version of a formerly transferred object a new Transfer Job is initiated 

for this revision. 

The following TaskSetting are supported. 

• initialStartTime: initial start time if no further run of this task is known. 

• objectType: Part types to search for. 

• objectName: object name to search for 

• itemId: item id pattern. 

• statusList: list of status to search for. 

• projectId: list of project ID’s to search for. 
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• force, removeExistingNotProvided, and withGeometricalConversion, are the 

settings for the created Jobs. 

o force: true to disable skip functionality 

o removeExistingNotProvided: true to remove existing children in 

3DEXPERIENCE. 

o withGeometricalConversion: true to convert the imports to 3DEXPERIENCE. 

• waitForDesignJobs: true to wait for the Jobs to finish. 

• writeReport: true to write a report in the persistent directory 

The objectType, objectName, itemId, statusList, and projectId can contain multiple 

entries with delimiting character “|”. 

Example Task setting for HandleReleasedPdmObjects, start the task at 2:00 AM and repeat the 

task every 24h. 

<Task name="Aras-Released" 

      startTime="2:00:00" 

      period="86400"  

      loadClass="com.tsystems.xci.scheduler.HandleReleasedPdmObjects"  

      type="FixedRate"> 

  <TaskSetting name="initialStartTime"> 

    2020-11-09T00:00:00.000Z 

  </TaskSetting> 

  <TaskSetting name="objectType">Part</TaskSetting> 

  <TaskSetting name="itemId"></TaskSetting> 

  <TaskSetting name="statusList">Released</TaskSetting> 

  <TaskSetting name="force">false</TaskSetting> 

  <TaskSetting name="removeExistingNotProvided">true</TaskSetting> 

  <TaskSetting name="withGeometricalConversion">true</TaskSetting> 

  <TaskSetting name="waitForDesignJobs">false</TaskSetting> 

  <TaskSetting name="writeReport">true</TaskSetting> 

</Task> 

3.6.2 HandleReleasedEnoviaObjects 

The HandleReleasedEnoviaObjects task queries for objects with a defined state in 

3DEXPERIENCE. If the found revision is a new version of a formerly transferred object a new 

Transfer Job is initiated for this revision. 

The following TaskSetting are supported. 

• initialStartTime: initial start time, if not provided the time of the first run is used. 

• objectType: revision types to search for (comma separated to search for multiple types). 

• objectName: title (V_Name) search pattern. 

• plmExternalId: part number (PLMExternalId) search pattern. 

• statusList: list of status to search for (comma separated to search for multiple types). 

• collaborativeSpace: list of collaborative spaces to search for (comma separated to 

search for multiple types). 

• force, and removeExistingNotProvided, are the settings for the created Jobs. 

o force: true to disable skip functionality 
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o removeExistingNotProvided: true to remove existing children in Aras Innovator. 

• waitForDesignJobs: true to wait for the Jobs to finish. 

• writeReport: true to write a report in the persistent directory 

Example Task setting for HandleReleasedEnoviaObjects, start the task at 2:00 AM and repeat 

the task every 24h. 

<Task name="TDX-Released" 

      startTime="2:00:00" 

      period="86400"  

      loadClass="com.tsystems.xci.scheduler.HandleReleasedEnoviaObjects"  

      type="FixedRate"> 

  <TaskSetting name="initialStartTime"> 

    2020-11-09T00:00:00.000Z 

  </TaskSetting> 

  <TaskSetting name="objectType">VPMReference</TaskSetting> 

  <TaskSetting name="objectName"></TaskSetting> 

  <TaskSetting name="plmExternalId"></TaskSetting> 

  <TaskSetting name="statusList">FROZEN,RELEASED</TaskSetting> 

  <TaskSetting name="collaborativeSpace">Common Space</TaskSetting> 

  <TaskSetting name="force">false</TaskSetting> 

  <TaskSetting name="waitForDesignJobs">false</TaskSetting> 

  <TaskSetting name="writeReport">true</TaskSetting> 

</Task> 

3.7 TSI3DXBatch 

Define installation of TSI3DXBatch to run 3DEXPERIENCE utilities, for example for import or export 

of files. 

TSI3DXBatch installations can be distributed to multiple hosts. Each installation has following 

settings. 

• id: identifier for this installation, must be unique 

• conversionServerUrl: optional, set URL of Conversion Server if this installation is on a 

remote host. If not specified, this installation is local on the same host as ACI server. 

• maxParallel: how many batches can run in parallel for this installation 

• cleanupWorkdir: true to remove workdir on Conversion Server if running remotely and 

execution was successful. Enabled by default. 

• sharedPersistentDir: true if Conversion Server and ACI integration server share 

persistent directory (e.g. via mapped network drive). Avoids file transfer to Conversion 

Server. Disabled by default. 

• CatStartPath: defines path to CATSTART.exe 

• CatStartEnv: defines name of 3DEXPERIENCE environment file 

• CatStartDirEnv: defines directory where environment file is located 

• Username: username for connecting to 3DEXPERIENCE 

• Password: password for connecting to 3DEXPERIENCE, encrypted by default (see 

installation manual for password encryption). Set plaintext flag to use password without 

encryption. 
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• SecurityContext: security context for connecting to 3DEXPERIENCE 

• LoginTicket: login ticket may be used instead of username, password and security 

context. If all are defined, login ticket is used. Encrypted by default (see installation manual 

for password encryption). Set plaintext flag to use login ticket without encryption. 

• JTV5: optional, path to script for convert exported CATIA files to JT after export 

• PrintTemplate: optional, path to template file for export of PDF for Drawings 

Supported TSI3DXBatch tasks are: 

• Cloc: transferring data mastership between Aras Innovator and 3DEXPERIENCE 

• EffectivityExport: export effectivites from 3DEXPERIENCE 

• FileExport: export files from 3DEXPERIENCE using DownwardCompatibility, 

DataExchangePLMBatch, PLMPrintBatch or Export 3DXML. 

• FolderExport: export folders from 3DEXPERIENCE 

• FolderImport: import folders to 3DEXPERIENCE 

• MappingInfo: export coexistence mapping information from 3DEXPERIENCE 

• Revise: revise objects in 3DEXPERIENCE 

• SetFilter: import structure filter to 3DEXPERIENCE 

• XPDMExport: export structure with XPDM from 3DEXPERIENCE 

• XPDMImport: import structure with XPDM to 3DEXPERIENCE 

Each task can contain a Target with a list of Installation to limit execution of the specific task 

to specific installations. If no Target is specified, the task can run on all installations. 

They can also contain a Timeout in seconds after which processing is terminated with error. 

Some tasks have task specific options: 

• Cloc: 

o ContextName: coexistence mapping context name. Default value is XPDM. 

• FileExport: 

o BatchInactivityTimeout: terminate with error when DownwardCompatibility or 

DataExchangePLMBatch do not change anything in the working directory for 

specified number of seconds. 

o DownwardCompatibility: 

▪ Format: target CATIA V5 format, must match CATIAVRxx for R18 – R21 or 

CATIAV5-6Rxxx for 2012 or greater 

▪ GeometryType3D: export geometries with specification tree 

(AsSpecifications) or as solid body (Exact). Default: 

AsSpecifications. Note: “AsSpecifications” works only for the 

corresponding CATIA V5 version e.g., for 3DEXPERIENCE 2021x the CATIA 

V5 target version is CATIA V5-6R2021. Also, early 3DEXPERIENCE releases 

like GA may not support the export of CATIA V5 CATParts with specifications 

at all. To make sure please check first if the 3DEXPERIENCE batch option is 

available: 
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▪ TemplateCATPart: create CATParts based on a template CATPart. Must 

specify full path. 

▪ RetryGeometryExport: retry geometry export if export of a list of objects 

fails, to isolate the failed object and export all other objects. Set to true or 

false. 

▪ JT_ContinueOnError: continue exporting if JT generation fails. Set to true 

or false. 

▪ CreateJtForClass: create JTs only for these 3DEXPERIENCE object 

types. Separate multiple types with “,”. Types must be subtypes of 

PLMCoreRepReference. Default: 3DShape. 

▪ CATFileFormatForJt: create JTs only for these file formats of exported 

files (e.g. CATPart). Separate multiple formats with “,”. Default: CATPart. 

o DataExchangePLMBatch: 

▪ MaxXCadBatchObjects: restrict maximum number of objects for a single 

DataExchangePLMBatch call. Default: 200. 

▪ XCadInvalidCharacters: replace invalid characters with “_” when 

constructing filenames for exported files. Default: \/:*?"<>| and tab character. 

o Export3DXML: 

o RepresentationExport: export all representations (All), export 3DShapes (Yes) 

or export no representations (No). Default: Yes. 

o Format: export with (WithAuthoring) or without authoring information (ForReview). 

Default: WithAuthoring. 

o PropagateDepth: how many structure levels are included in the export: All, 1, 2, 3, 

… Default: All 

o CompatibilityMode: export 3DXML in compatibility mode: Yes or No. Default: 

Yes. 

o CompatibilityLevel: Specify compatibility level when exporting in compatibility 

mode: CompatibilityLevel2013x, CompatibilityLevel2020x. Only available from 2021x 

onwards. If defined, CompatibilityMode will be automatically set to YES. Default: 

none. 

• MappingInfo: 

o MappingInfoResult: All to export MappingInfo result to one file. Each for one 

result file for each mappinginfo entry in the input file. Default value is All. 

o MappingInfoExposed: TRUE to export only exposed mapping. FALSE to export 

exposed and internal mapping. Default value is TRUE. 

o ContextName: mapping context name. Default value is XPDM. 

• XPDMExport: 

o FileFormat3D: target CATIA V5 format for geometry export 

o GeometryType3D: type of geometry to export. Exact transfers the authoring data, 

Tesselated transfers the visualization data, AsSpecifications exports all 

specifications information 

o FileFormat2D: target CATIA V5 format for 2D Drawing export 

o SiteId: defines mapping context. Default value is XPDM. 

o WithFiles: Yes to export files. No to not export files. IfModified to only export 

Modified Files. Default value is Yes. 

o WithDocuments: Yes to export non-CAD documents. No to not export non-CAD 

documents. Default value is Yes. 
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o WithPLMParams: Yes to export PLM Parameter. No to not export PLMParameter. 

Default value is Yes. 

• XPDMImport: 

o SiteId: defines mapping context. Default value is XPDM. 

To limit concurrent usage globally you can define a resource in ResourceBalacner (see 3.1.20) 

and reference the resource. 

When distributing to remote hosts, XCIServerUrl must be defined – see 3.1.27. 

Following example defines one local installation and one remote installation. Task specific options 

are configured for XPDMExport and FileExport. All other tasks run with default parameters.  

XPDMExport can only run on the remote installation and all other batch tasks can run on both 

installations. XPDMExport and FileExport tasks use resource V6 to globally limit usage with 

ResourceBalancer, all other not explicitly defined tasks are not limited. 

<TSI3DXBatch> 

  <InstallationList> 

    <Installation id="tsi3dxbatch-cs-1"  

                  conversionServerUrl="http://remote-host:8080/XCI_CS"               

                  maxParallel="4"> 

      <CatStartPath> 

        C:\Program Files\DassaultSystemes\B426\win_b64\code\bin\ 

        CATSTART.exe 

      </CatStartPath> 

      <CatStartEnv>XCI_3DX_BATCH_Env</CatStartEnv> 

      <CatStartDirEnv> 

        C:\Program Files\T-Systems\XCI_3DX_BATCH_R2024x_V3.11.0.0\ 

        config 

      </CatStartDirEnv> 

      <LoginTicket plaintext="true">XXX</LoginTicket> 

    </Installation> 

    <Installation id="tsi3dxbatch-local" maxParallel="2"> 

      <CatStartPath> 

        C:\Program Files\DassaultSystemes\B426\win_b64\code\bin\ 

        CATSTART.exe 

      </CatStartPath> 

      <CatStartEnv>XCI_3DX_BATCH_Env</CatStartEnv> 

      <CatStartDirEnv> 

        C:\Program Files\T-Systems\XCI_3DX_BATCH_R2024x_V3.11.0.0\ 

        config</CatStartDirEnv> 

      <LoginTicket plaintext="true">XXX</LoginTicket> 

    </Installation> 

  </InstallationList> 

     

  <XPDMExport resource="V6"> 

    <Target> 

      <Installation>tsi3dxbatch-cs-1</Installation> 

    </Target> 

    <FileFormat3D>CATIAV5-6R2024</FileFormat3D> 
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    <GeometryType3D>AsSpecifications</GeometryType3D> 

    <FileFormat2D>CATIAV5-6R2024</FileFormat2D> 

  </XPDMExport> 

     

  <FileExport resource="V6"> 

    <DownwardCompatibility> 

      <Format>CATIAV5-6R2024</Format> 

      <GeometryType3D>asSpeCifIcation</GeometryType3D> 

    </DownwardCompatibility> 

  </FileExport> 

</TSI3DXBatch> 

3.8 COMReconV5 

Define installation of COMReconV5 and enable or disable Preprocessing or Postprocessing of 

CATIA V5 files. 

To enable, include V5ToV6Preprocessing or V6ToV5Postprocessing. To disable, omit the 

settings. 

COMReconV5 installations can be distributed to multiple hosts. Each installation has following 

settings. 

• id: identifier for this installation, must be unique 

• conversionServerUrl: optional, set URL of Conversion Server if this installation is on a 

remote host. If not specified, this installation is local on the same host as ACI server. 

• maxParallel: how many batches can run in parallel for this installation 

• cleanupWorkdir: true to remove workdir on Conversion Server if running remotely and 

execution was successful. Enabled by default. 

• sharedPersistentDir: true if Conversion Server and ACI integration server share 

persistent directory (e.g. via mapped network drive). Avoids file transfer to Conversion 

Server. Disabled by default. 

• COMReconPath: base installation path of COMReconV5 

V5ToV6Preprocessing or V6ToV5Postprocessing can contain a Target with a list of 

Installation to limit execution of the specific task to specific installations. If no Target is 

specified, the task can run on all installations. 

They can also contain a Timeout in seconds after which processing is terminated with error. 

To limit concurrent usage globally you can define a resource in ResourceBalacner (see 3.1.20) 

and reference the resource. 

When distributing to remote hosts, XCIServerUrl must be defined – see 3.1.27. 

Following example defines one local installation and one remote installation. 

V6ToV5Postprocessing can only run on the remote installation and V5ToV6Preprocessing 

can run on both installations. Both tasks use resource V5 to globally limit usage with 

ResourceBalancer. 

<COMReconV5> 

  <InstallationList> 
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    <Installation id="comrecon-cs-1"  

                  conversionServerUrl="http://remote-host:8080/XCI_CS"  

                  maxParallel="4">        

      <COMReconPath> 

        C:\ACI\COMReconV5\240613_COMReconV5_R34 

      </COMReconPath> 

    </Installation> 

    <Installation id="comrecon-local" maxParallel=”2”> 

      <COMReconPath> 

        C:\ACI\COMReconV5\240613_COMReconV5_R34 

      </COMReconPath> 

    </Installation> 

  </InstallationList> 

  

  <V5ToV6Preprocessing resource=”V5” /> 

  

  <V6ToV5Postprocessing resource=”V5”> 

    <Target> 

      <Installation>comrecon-cs-1</Installation> 

    </Target> 

    <Timeout>120000</Timeout> 

  </V6ToV5Postprocessing> 

</COMReconV5> 

3.9 FileConversion 

Define file conversion batches which can convert exported files after Aras Innovator export to 

different formats. 

Batch installations can be distributed to multiple hosts. Each installation has following settings. 

• id: identifier for this installation, must be unique 

• conversionServerUrl: optional, set URL of Conversion Server if this installation is on a 

remote host. If not specified, this installation is local on the same host as ACI server. 

• maxParallel: how many batches can run in parallel for this installation 

• cleanupWorkdir: true to remove workdir on Conversion Server if running remotely and 

execution was successful. Enabled by default. 

• sharedPersistentDir: true if Conversion Server and ACI integration server share 

persistent directory (e.g. via mapped network drive). Avoids file transfer to Conversion 

Server. Disabled by default. 

ConversionTask specify a concrete conversion from an input format to an output format. 

• inputType: input format 

• outputType: output format 

• onlyConvert: only convert the file and do not add it to the structure. Disabled by default. 

• acceptList: indicate if this task accepts a list of files as input instead of a single file. Default 

value is true. 
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ConversionTask can contain a Target with a list of Installation to limit execution of the specific 

task to specific installations. If no Target is specified, the task can run on all installations. 

ConversionTask can contain a Timeout in seconds after which processing is terminated with 

error. 

To limit concurrent usage globally you can define a resource in ResourceBalacner (see 3.1.20) 

and reference the resource. 

When distributing to remote hosts, XCIServerUrl must be defined – see 3.1.27. 

Input to a file conversion task is passed in environment variable XCI_CONVERT_INFO. This variable 

points to a text file where each line contains a mapping of input file path to output file path separated 

by pipe character “|”. The script should parse the input path, convert the file and write it to the output 

path. 

Following example defines two file conversion tasks to different output formats that run on different 

installations. 

<FileConversion> 

  <InstallationList> 

    <Installation id="cgrconv-cs-1"  

                  conversionServerUrl="http://remote-host:8080/XCI_CS"             

                  maxParallel="4"> 

      <ConversionCommand>C:\ACI\cgrconv.bat</ConversionCommand> 

    </Installation> 

    <Installation id="jtconv-local" maxParallel=”2”> 

      <ConversionCommand>C:\ACI\jtconv.bat</ConversionCommand> 

    </Installation> 

  </InstallationList> 

   

  <ConversionTaskDefinitions> 

    <ConversionTask resource="V5"  

                    inputType="CATPart"  

                    outputType="jt"  

                    onlyConvert="true"> 

      <Target> 

        <Installation>jtconv-local</Installation> 

      </Target> 

    </ConversionTask> 

         

    <ConversionTask resource="V5"  

                    inputType="CATPart"  

                    outputType="cgr"  

                    onlyConvert="true"> 

      <Target> 

        <Installation>cgrconv-cs-1</Installation> 

      </Target> 

    </ConversionTask> 

  </ConversionTaskDefinitions> 
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</FileConversion> 


